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About ParaView 

CScADS : Scientific Data and Analytics for 
Petascale Computing Workshop 

Outline 

•  About ParaView 
•  Short Tutorial 
•  Current Work in Progress 
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History (http://www.paraview.org/Wiki/ParaView_Release_Notes 

•  1999 LANL/Kitware project (via ASCI Views) 
–  Build an end user tool from VTK 
–  Make VTK scale 
–  October 2002 first public release, version 0.6 

•  2002-2005 Versions 0.6 through 2.6 
–  Continued growth under DOE Tri Labs, Army 

Research Lab and various other partnerships  

•  September 2005 ParaQ project started 
–  Sandia, Kitware and CSimSoft 
–  Make ParaView easier to use 
–  Add quantitative analysis 
–  May 2007 version 3.0 released 

•  Continuing to evolve 
–  3.8 released May 2010 – release every 3 months 

Community   
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Community  
•  Downloads 

 Jun 2010, 14772 

+  Packagers: 
 Debian, Ubuntu, 
Gentoo, Fedora, 
FreeBSD, Fink 

+  source checkouts 
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http://www.ohloh.net/p/3249/analyses/latest Codebase (LOC)  777,161  
Effort (est.)  213 Person Years  
Avg. Salary  $ 55000 year   

  $ 11,731,047   

June 2010 cvs -> git transition 
now on 3 month release schedule 
http://www.paraview.org/Wiki/ParaView_Release_Notes 
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An application and architecture for display and analysis of massive  
scientific datasets.  

What is ParaView? 

An application and architecture for display and analysis of massive 
scientific datasets.  

•  End User Visualization Tool 
–  Do not have to be a programmer* 
–  Wraps many of the important VTK filters into an Application** 
–  Extensive searchable help 
–  Undo/Redo 
–  Configurable layout in preferences 

  *  Can even be a rocket scientist. 
  ** Those not wrapped are easy to add 

What is ParaView? 
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•  File->Open 
–  Read in structured (uniform rectilinear, non-uniform 
rectilinear, and curvilinear grids), unstructured, polygonal, 
image, multi-block, AMR and time varying data  

•  Filter->Choose Filter 

•  Tune filter parameters via dialogs and 3D Widgets  
•  Repeat at Step 2 as desired 

–  Build up arbitrary VTK pipelines that Isosurface, Clip, Warp, 
–  Glyph, Streamline… 

•  Save in a variety of formats 

Processing and visualization 

Reader 

Data 

Filter 

Data´ 

An application and architecture for display and analysis of massive 
scientific datasets. 

•  Open source (BSD license) and Cross Platform 

•  Extensible 
–  At compile time via External Code Module Interface 
–  At runtime via python scripting  
–  At runtime via dynamically loaded C++ plugins 
–  “Branding” infrastructure to makes new applications  

 Pick and choose what parts you need 
 Extend and customize as you see fit 

What is ParaView? 
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An application and architecture for display and analysis of massive  
scientific datasets.  

•  Each filter’s output can be independently controlled 
–  Points, Surface/Edges, Volume Rendering representations 
–  Interactive Lookup Table(LUT)  Editing/Saving 
–  LUT per variable, per data set, per view 

•  Simultaneous display in multiple viewing windows 
•  Augment view with a variety of Annotations 

What is ParaView? 
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An application and architecture for display and analysis of massive 
scientific datasets.  

•  Chart, Plot and Spreadsheet View types 
–  Probe along a curve and get 2D plot of values along the line 
–  Display coordinates and data values as text in a spreadsheet, or on 

screen via Selection labels 
•  Drag mouse in View to visually select the important data 
•  Find Data queries 
•  Calculator and Programmable filters let you perform arbitrary data 

manipulation at runtime 
•  Import and export to .csv and many other formats 

What is ParaView? 

•  Selection is linked among all views (whenever possible) 

•  Make a selection in any View, it becomes the Active selection 
and is shown in all other views (whenever possible) 

Selection linking 
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An application and architecture for display and analysis of massive  
scientific datasets. 

•  Client/Server architecture lets it runs on variety of platforms  
–  from netbooks 
–  to the largest machines in the world  

•  Support for tile display and parallel rendering 
•  Level of detail techniques keep it interactive on huge data 

What is ParaView? 

Extremely large data 
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serial batch combined server 
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Processing extremely large data 
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Rendering extremely large data 
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Depth Composite Tile Display 

* Depending on geometry size threshold, ParaView will 
dynamically render locally (sending geometry to client) or 
remotely (sending images to client). 

* 
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•  CTH shock physics, over 1 billion cells 

Golevka asteroid vs.10 megaton explosion 

•  SEAM Climate Modeling, 1 billion cells (500 million cells visualized). 

Polar vortex breakdown 
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•  Coupled SIERRA/Fuego/Syrinx/Calore, 10 million unstructured 
hexahedra 

Objects-in-Crosswind fire 

Large scale AMR 
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•  UI and Help 
•  Load data, Inspect it 
•  Show the Data: representations, color map, multiview, animate 
•  Query the Data 
•  Work with the Data 

–  Slice, warp, streamline/tube, histogram, plot, temporal interpolate, 
python programmable filter 

•  Save the Results 
•  Script it 

Using ParaView a tutorial 
(see also http://www.paraview.org/Wiki/The_ParaView_Tutorial) 

User interface 

Menu Bar 

Toolbars 

Pipeline Browser 

Object Inspector 

View(s) 
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Online help 
•  Searchable help system 
•  Authored pages 
•  Generated pages 

–  for every accessible 
method 
of every reader, source, 
filter and writer 

•  Duplicated online 

Load data : file formats 

•  Kitware formats:  
 (.vtk, .pvd, .vt?, pvt*) 

•  Exodus 
•  Xdmf annotated hdf5 

(.xmf, .xdmf) 
•  SpyPlot CTH 
•  EnSight (.case, .sos) 
•  netCDF CF (.ncdf, .nc) 
•  Protein Data Bank (.pdb) 
•  XMol Molecule 
•  PLOT3D 
•  LS-DYNA 

•  SESAME Tables 
•  POP Ocean Files 
•  AVS UCD (.inp) 
•  Digital Elevation Map (.dem) 
•  VRML (.wrl) 
•  Phasta Files (.pht) 
•  MFIX (.RES) 
•  Tecplot ASCII (.tec, .tp) 
•  Fluent Case Files (.cas) 
•  OpenFOAM Files (.foam 
•  Flash multiblock files 
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More file formats 

•  Enzo boundary and 
hierarchy 

•  Gaussian Cube File (.cube) 
•  Facet Polygonal Data 
•  LANL cosmology data 

(.cosmo) 
•  LANL windbade (.wind) 
•  LANL VPIC (.vpc) 
•  SLAC netCDF mesh, mode 

and particle data 
•  Stereo Lithography (.stl) 
•  Meta Image (.mhd, .mha) 

•  BYU (.g) 
•  Stanford Polygonal (.ply) 
•  Wavefront Polygonal Data 

(.obj) 
•  PNG Image Files 
•  TIFF Image Files 
•  Raw Image Files 
•  NRRD image files (.nrrd) 

•  Comma Separated Values 
(.csv) 

•  Python scripted readers 

More file formats 

Via Plugins 
•  NIH Analyze/Nifti 
•  H5part HDF5 Particle 

files 
•  .tlp tulip graphs 
•  .xml tree structures 
•  netdmf 
•  sql table interface 
•  prism sesame files 

Coming soon 
•  visit formats: enzo, fluent, 

miranda, pixie, netcdf, 
pdb, samrai, silo*, tertrad, 
+visit extensions 

•  NCAR vapor data format 
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Inspect the data 
•  Information about the Active 

Filter’s output 
•  DataObject structure 
•  Size (Bytes, #points, #cells) 
•  Geometric bounds 
•  Structured bounds 
•  Arrays: 

–  Name 
–  Association (point,   cell) 
–  Data Type 
–  Value Ranges 

•  Temporal Domain 

•  Views – Windows onto one or more data sets 

Display the data 
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•  Representations (aka Displays) – visual characteristics of one 
particular data set in one particular view 

Display the data 

Points Wireframe Surface Surface 
with Edges 

Volume 

MultiView visualization pipeline 

Data 

Filter 

Source 

Filter 

Data View 

Representation 

View 

Data Representation 

Representation 

Representation 

Representation 

Representation 
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•  Accessible on toolbar above each view 
•  As are camera and multiview controls 

View controls 

•  Split, maximize, and close buttons on top right 
•  Click in a view to make it active then rest of application (view 

controls, display tab etc) pertain to it 
•  CTRL->Right Mouse to link cameras 

Multiview 
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•  Choose a filter in the pipeline browser 
•  Object Inspector’s Display tab controls how it’s data will look in the 

active view 

Representation controls 

Representation controls 

Toggle Color 
Legend 

Mapped 
Variable Representation Vector 

Component 

Edit Colors 

Reset Scalar 
Range 
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Transfer function editor 

Query the data 
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•  Visually select interesting data 
•  shown in all compatible views 
•  can then label, extract etc 

–  ‘Select Cells On’ to get 
nearest cells  

–  Select Points On’                        
to get nearest points 

–  ‘Select Cells Through’ to get 
all cells intersecting a frustum 

–  ‘Select Points Through’                        
for selecting points inside a 
frustum 

Selection 

•  Filters Menu 
–  Recent 
–  Common 
–  Data Analysis 
–  Statistical 
–  Temporal 
–  Alphabetical 

•  Quick Launch 
–  PC/Linux  CTRL-Space 
–  Mac  ALT-Space 

•  Apply Undo/Redo 

Manipulate the data 

Calculator 

Contour 

Clip 

Slice 

Threshold 

Extract 
Subset 

Glyph 

Stream Tracer 

Warp (vector) 

Group Datasets 

Extract Group 
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•  Use pipeline browser to navigate the graph 
•  Select a reader/filter to make it active, then object inspector, 

information tab and display tab pertain to it 

Pipeline Browser : condensed pipeline graph 

Disk_out_ref.ex2 

Contour1 DataSetSurfaceFilter1 

Clip1 

•  Properties Tab of Object Inspector 
•  Text controls <-> 3D Widgets 
•  Reset 
•  Apply 
•  Help 
•  Delete 

Filter parameters 
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Slice -> Warp 

Streamline -> Tube 
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Plot Over Line, Histogram 

Temporal Interpolate 
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•  Write python wrapped VTK code on the server at runtime 
•  Examples at: 

http://www.paraview.org/Wiki/Python_Programmable_Filter 

•  Python Calculator variant uses simple (numpy) array syntax 
•  Programmable source variant is an easy path to data import 

Python Filter - a whitebox filter 

D
ata 
In 

D
ata 

O
ut ? 

<your code here> 
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Python scripting 
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•  File->Save * 
–  Active filter’s data, prompted for file format 

–  Screen shot, either selected view or all  

–  Movie 
•  Image sequence, avi, ogg, ffmpeg->avi 

–  State – for restoring ParaView session later 

Exporting data, images, sessions 

•  An application and architecture for display and analysis of massive 
scientific datasets. Which is rapidly evolving. 

•  ParaView’s distinguishing feature is that it is highly extensible and 
reusable. 

What is ParaView? 
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•  * SLAC plugin (3.6) 
–  Collection of tools for Stanford Linear Accelerator Center users 

•  * Branding infrastructure (3.8) 
–  Modular Qt GUI infrastructure to enable more derived applications 

•  * ERDC tools (3.6) 
–  ParaView as Pre-Processor, model builder 
–  Generate input files for Army’s Engineering Research and Development 

Center FEM simulation tools 
•  Visit Databases Plugin (3.6.1) 

–  Adapter for Visit Database enabled file formats 
–  3.10 brings second incarnation 

•  Vistrails Plugin (3.6.2) 
–  Vistrails connects to ParaView accept and undo redo to give graphical 

representation of provenance and interface to make use of it 

Recent/Ongoing work 

•  Python Trace (3.6.2) 
–  Record actions taken in GUI as human readable python scripts 

•  CVS->Git transition 
–  Improve releases and involve more contributors 

•  * Adaptive Streaming ParaView (3.8) 
–  Multiresolution visualization, skipping unimportant portions of data 

•  Development Binaries (3.8) 
–  Develop plugins that work with Kitware binaries 

•  LIC rendering (3.8), Manta Ray Tracer (3.8), GPU Glyphs (3.10) 
–  New rendering techniques 

Recent/Ongoing work 
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•  * ParaviewWeb (3.8) 
–  Collaborative web interface to ParaView service 
–  http://paraviewweb.kitware.com/PW/ 
–  http://www.paraview.org/Wiki/ParaViewWeb 

•  Improved 2D VTK charting components (3.8)  
–  Parallel coordinates view (3.10) 

•  Vapor Plugin (3.10) 
–  Interface to NCAR Vapor Data Format wavelet compressed data 

•  Coprocessing, Live Data and Computational Steering (3.10) 
–  Visualize what is being produced, as it is being produced 

Recent/Ongoing work 

•  4.0 major overhauls are in progress 
–  Streamlined GUI to be more intuitive 
–  Lightweight server control constructs 
–  Modular rendering classes 
–  Composable VTK/ParaView libraries 

Recent/Ongoing work 
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•  Wiki Page 
–  http://www.paraview.org/Wiki/ParaView  

•  Mailing List  
–  Sign up->http://public.kitware.com/mailman/listinfo/paraview  
–  Search ->http://markmail.org/search/?q=list:paraview 

•  User Voice 
–  Feature request voting 

•  Bug Tracker 
–  http://www.paraview.org/Bug/my_view_page.php  
–  Project:-> ParaView3 

•  Source Code Documentation 
–  http://www.paraview.org/ParaView3/Doc/Nightly/html/classes.html  

•  Regression Testing 
–  http://www.cdash.org/CDash/index.php?project=ParaView3 

http://www.paraview.org  
        portal to all things paraview 


